IFMBE Proceedings Series—Instructions for Authors

A.B. Firstauthor\textsuperscript{1}, C. Coauthor\textsuperscript{2} and D.E. Othercoauthor\textsuperscript{1}

\textsuperscript{1}Institution/Department, Affiliation, City, Country
\textsuperscript{2}Institution/Department, Affiliation, City, Country

Abstract—Instructions for preparing papers for IFMBE-Proceedings Series are presented. They are intended to guide the authors in preparing the electronic version of their paper. Only papers prepared according to these instructions will be published in the paper and online version of Proceedings. Provide an abstract of your paper no longer than 300 words.

Keywords—Enter up to five keywords and separate them by commas.

I. INTRODUCTION

These are the instructions for preparing papers for the IFMBE Proceedings Series. English is the official language. Please, do not forget to prove the spelling with your spell checker. Set the language to English (U.S.). Read the instructions in this sample paper carefully before typing.

The papers should be submitted in their final form. The publisher will perform no further adjustments. In the Proceedings the papers will be reproduced directly from the files submitted by the authors. The authors must upload their paper in MS Word and Pdf format through the conference management system.

Detailed instructions for preparing the papers are listed in chapter II. WRITING THE PAPER. When you write the paper, you can either follow the descriptive rules presented in subchapter A. Descriptive rules, or install the macros prepared by the publisher, as described in subchapter B. Using macros.

II. WRITING THE PAPER

A. Descriptive rules

\textbf{Paper Size:} Select the custom size of paper, i.e. 21 x 27.9 cm in Page Setup in your Word Processor. Only this paper size can be accepted.

\textbf{Length:} The maximum document size for regular and Young Investigator Competition papers is four pages. Abstracts only will not be published.

\textbf{Margins:} The page layout should be "mirror margins". Leave 2.5 cm margin at the top, 4 cm at the bottom, 1.9 cm on the inside and 1.4 cm at the outside side of the page.

\textbf{Page Layout:} Type the paper in two columns 85.5 mm wide with a space of 6 mm between the columns. Each column should be left and right justified.

\textbf{Fonts:} Use Roman typeface (e.g. Times, Times New Roman) and single line spacing throughout the paper.

\textbf{Title:} The title should be no longer than two lines. Avoid unusual abbreviations. Center the title (14 point bold). Authors’ names and affiliations (Institution/Department, City, Country) shall span the entire page. Leave one blank line (8 point) after the title, one blank line (10 point) after the authors’ names and affiliations. Leave one blank line (20 point) between author’s info and the beginning of the paper.

\textbf{Abstract:} Provide an abstract of the paper (9 point bold) no longer than 300 words.

\textbf{Style:} Use separate sections for introduction, materials and methods, results, discussion, conclusions, acknowledgments (when appropriate), and references.

\textbf{Headings:} Enumerate Chapter Headings by Roman numbers (I., II., etc.). For Chapter Headings use ALLCAPS. First letter of Chapter Heading is font size 12, regular and other letters are font 8 regular style. Leave one blank line (20 point) before and one blank line (10 point) after each Chapter Heading. Subchapter Headings are font 10, italic. Enumerate Subchapter Headings by capital letters (A., B., etc.). Leave one blank line (15 point) before and one blank line (7.5 point) after each Subchapter Heading.

\textbf{Body Text:} Use Roman typeface (10 point regular) throughout. Only if you want to emphasize special parts of the text use Italics. Start a new paragraph by indenting it from the left margin by 4 mm (and not by inserting a blank line). Font sizes and styles to be used in the paper are summarized in Table 1.

\textbf{Tables:} Insert tables where appropriate (as close as possible to where they are mentioned in the text). Prefer positioning them at the top or at the bottom of the column. If necessary, span them over both columns. Enumerate them consecutively using Arabic numbers and provide a caption for each table (e.g. Table 1, Table 2,...). Use font 10 regular for Table caption, 1st letter, and font 8 regular for the rest of table caption and table legend. Place table captions and table legend above the table. Leave one blank line before (15 point) and one after (5 point) the captions. Please keep in mind the distinction between tables and figures: tables.
only contain alphanumerical characters and no graphical elements.

<table>
<thead>
<tr>
<th>Table 1 Font sizes and styles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
</tr>
<tr>
<td>Title</td>
</tr>
<tr>
<td>Author</td>
</tr>
<tr>
<td>Authors’ info</td>
</tr>
<tr>
<td>Abstract</td>
</tr>
<tr>
<td>Keywords</td>
</tr>
<tr>
<td>Body text</td>
</tr>
<tr>
<td>Chapter heading, 1st letter</td>
</tr>
<tr>
<td>Chapter heading, other letters</td>
</tr>
<tr>
<td>Subchapter heading</td>
</tr>
<tr>
<td>Table caption, 1st letter</td>
</tr>
<tr>
<td>Table legend</td>
</tr>
<tr>
<td>Column titles</td>
</tr>
<tr>
<td>Table data</td>
</tr>
<tr>
<td>Figure caption, 1st letter</td>
</tr>
<tr>
<td>Figure legend</td>
</tr>
<tr>
<td>Acknowledgment</td>
</tr>
<tr>
<td>References</td>
</tr>
<tr>
<td>Author’s address</td>
</tr>
</tbody>
</table>

**References**: Use Arabic numbers in square brackets to number references in such order as they appear in the text. List them in numerical order as presented under the heading ‘REFERENCES’ at the end of this Instructions.

**B. Using macros**

**a) Word2003**:  
Macro security: Change in MSWord the basic setting “macro security” as described:  
Menu bar: “Tools → Macro → Security → Middle or Medium“

**b) Word2007**:  
Macro security: Change in MSWord the basic setting “macro security” as described:  
Menu bar: “Trust Center → Macro Settings → Security → Warnings for all macros“

Activating the “Developer tab” in order to display the macro buttons:  
Click the Microsoft Office Button and then click “Word Options”. Click “Popular”, and then select the “Show Developer tab” in the Ribbon check box.  
Now the macro buttons can be found at “Add-Ins” in the menu.

**c) Word2003 and Word2007**:  
Restart MS Word again. A message will appear on the screen stating that the file you are using contains Macros. Click at “Enable Macros”.

**File deposition**: Copy the file IFMBE_Proceedings_Template_2.dot into the same folder in which your word-templates are usually located (e.g. the template “normal.dot”).

**Writing the article**: When you start working with the template you have (amongst others) the following two options:  
Highlight the file IFMBE_Proceedings_Template_2.dot in the Explorer and choose in the menu “File → New”.  
Open a new or an existing word-document and select in menu Tools the item “Templates and Add-Ins”. Click in the Window on “Connect”, choose IFMBE_Proceedings_Template_2.dot, set a check on “Update Templates Automatically” and click OK.

**Page setup**: The page setup in this template is set to custom size of paper, i.e. 21 x 27.9 cm. The margins should be preset to “mirror margins”. In case the margins are not pre-
set as “mirror margins”, use the macro \[margins\] and choose the option \[mirror margins\] on the menu bar.

**Document structure:** The first part contains a column with the paper title, the author(s) names, initials and authors’ affiliation information. The title should be no longer than two lines. Avoid unusual abbreviations. Authors’ names and affiliations (Institution/Department, City, Country) shall span the entire page. The second part includes two columns and starts with Abstract and Keywords. For formatting any of these items, you may use macros from the menu bar \[article head\]. Click on the \[article head\] button and choose the appropriate format from the falling menu.

**Heading styles:** Templates for paragraphs are defined with attributes of paragraphs (justification, distances in front and after a paragraph etc.) and font. If you use the Heading1 \[H1\] macro from the menu bar for formatting the headings of the paragraphs - the first letter will be written in capital letters and formatted two points larger than the other letters in the heading. Please write the text and then click button \[H1\] on the menu bar once again. If second level heading - Heading2 \[H2\] immediately follows Heading1 use macro \[heading2_heading1\] from the menu bar to format the heading. This macro prevents double distances between Heading1 and Heading2.

**Macros for characters:** With macros \[characters template\] you can format individual characters or words within a paragraph in font style: bold, italic, symbol, initial etc.

<table>
<thead>
<tr>
<th>Table 2 Table caption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table legend</td>
</tr>
<tr>
<td>Table data</td>
</tr>
</tbody>
</table>

**Importing Tables:** This template enables you to format tables within one column. In order to insert a table please use the macro \[table\] from the menu bar and click on \[create table complete\].

You will be asked for the number of rows and columns in your table. Please enter the number of rows and columns into the Input box. The table will be inserted in the document and completely formatted.

The first letters in the caption of Table and Figure will be formatted two points larger as described for Heading1. You have to use the macro \[initial_10\] from the menu offered by clicking on the button \[characters template\] menu.

To align the table to the column width, click the button \[table\] on the menu bar, and then choose \[table column width\] from the offered menu.

**Importing figures:** In order to insert a figure, click the button \[figure\] on the menu bar, and then choose \[insert figure complete\] from the offered menu. Select in the window the figure you want to import and click on “insert”.

The figure caption is formatted with the macros and the \[figlegend\] and \[counter figure\] from the menu bar.

**Equation:** Write the equation in equation editor. Equations are formatted with the macro \[equation\].

\[ A + B = C \]  \hspace{1cm} (1)

In order to insert the equation number click the button \[equation\] on the menu bar and then choose \[counter equation\] from the offered menu. Separate the equation and the equation number by using the right tab on the keyboard. In order to achieve the requested spacing between the paragraphs and the equation click the button \[equation\] on the menu bar and then choose \[template equation\].

\[ X = A \times e^{\pi} + 21kt \]  \hspace{1cm} (2)

**Enumeration:** There are two different kinds of formatting for enumerations. In order to use bullets, click the button \[item\] on the menu bar, and then choose \[itemize\]. In order to use numbering select the text, click the button \[item\] on the menu bar, and then choose \[enumerate\] in order to start the numbering with number 1 or choose \[enumerate (cont)\] in order to continue the numbering.

\item itemize
\item Macro: \[item–itemize\]
\item 1. enumerate
\item 2. Macro: \[item–enumerate\]
To continue numbering:
\item Macro: \[item–enumerate (cont)\].

**Acknowledgment:** For formatting the headlines without numbering (e.g. Acknowledgment and References) use the style “\textbf{HEADING1}_{WITHOUTNR}“ from the style drop menu.

**References:** For automatically numbering of your references use the style: \[reference Item\] from the menu bar. The Internet addresses should be formatted with \[reference_available\].
III. COMPLIANCE WITH ETHICAL REQUIREMENTS

A. Conflict of Interest

When an author or the institution of the author has a relationship, financial or otherwise, with individuals or organizations that could influence the author’s work inappropriately, a conflict of interest may exist. Examples of potential conflicts of interest may include but are not limited to academic, personal, or political relationships; employment; consultancies or honoraria; and financial connections such as stock ownership and funding. Although an author may not feel that there are conflicts, disclosure of relationships and interests that could be viewed by others as conflicts of interest affords a more transparent and prudent process. All authors must disclose any actual or potential conflict of interest. The Proceedings will publish such disclosures if judged to be important to readers.

B. Statement of Informed Consent

Patients have a right to privacy that should not be infringed without informed consent. Identifying information, including patients’ names, initials, or hospital numbers, should not be published in written descriptions, photographs, and pedigrees unless the information is essential for scientific purposes and the patient (or parent or guardian) gives written informed consent for publication. Informed consent for this purpose requires that a patient who is identifiable be shown the manuscript to be published. Authors should identify individuals who provide writing assistance and disclose the funding source for this assistance.

Identifying details should be omitted if they are not essential. Complete anonymity is difficult to achieve, however, and informed consent should be obtained if there is any doubt. For example, masking the eye region in photographs of patients is inadequate protection of anonymity. If identifying characteristics are altered to protect anonymity, such as in genetic pedigrees, authors should provide assurance that alterations do not distort scientific meaning and editors should so note.

C. Statement of Human and Animal Rights

When reporting experiments on human subjects, authors should indicate whether the procedures followed were in accordance with the ethical standards of the responsible committee on human experimentation (institutional and national) and with the Helsinki Declaration of 1975, as revised in 2000 and 2008. If doubt exists whether the research was conducted in accordance with the Helsinki Declaration, the authors must explain the rationale for their approach, and demonstrate that the institutional review body explicitly approved the doubtful aspects of the study. When reporting experiments on animals, authors should be asked to indicate whether the institutional and national guide for the care and use of laboratory animals was followed.

IV. CONCLUSIONS

Send your papers only in electronic form. Papers must be uploaded before the deadline. After a paper is accepted for oral or poster presentation, one of the authors must complete a registration form and pay the appropriate fees before the paper can be published in the Proceedings. Please pay attention to the registration deadline.

To view the prescribed text boundaries of the paper use macro [view] on the menu bar and then choose [recommended view]. In order to reset this option choose option [undo recommended] from the menu bar [view].

ACKNOWLEDGMENT

Format the Acknowledgment and References headlines without numbering.

CONFLICT OF INTEREST

Every paper must contain a declaration of conflicts of interest. If there are no such conflicts write “The authors declare that they have no conflict of interest”.

REFERENCES

The list of References should only include papers that are cited in the text and that have been published or accepted for publication. Citations in the text should be identified by numbers in square brackets and the list of references at the end of the paper should be numbered according to the order of appearance in the text. Examples of citations for Journal articles [1], books [2], the Digital Object Identifier (DOI) of the cited literature (which should be added at the end of the reference in question if available) [3], Proceedings papers [4] and electronic publications [5].

Cited papers that have been accepted for publication should be included in the list of references with the name of the journal and marked as “in press”. The author is responsible for the accuracy of the references. Journal titles should be abbreviated according to Engineering Index Inc. References with correct punctuation.
5. IFMBE at http://www.ifmbe.org